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Chapter 1: Overview

iITero Optical Impression Device

The iTero Optical Impression Device is a mobile office unit that contains all of the necessary
hardware and software components for performing case scanning. Once a case has been
scanned and viewed, it may be uploaded to the Cadent Center for further processing.

Main Features

= PC-based system

LCD monitor with built-in speakers
Optical scanner with flexible cable
Integrated keyboard

Wireless mouse

Wireless foot pedals

Four lockable wheels

Two ventilation fans (inside grids)

O I RV

Wireless internet connection
= Internal UPS

NOTE: For detailed hardware specifications,
see the Operation Manual.

Booting the System

To turn the system on/off, press the blue
“‘“POWER” button above the keyboard. For
further operation details, refer to the Operation
Manual.

About This User Guide

This User Guide describes how to use the iTero Scanner application to scan cases, and how
to use the Case Manager application to monitor case status. From within each application,
you may press F1 to access context-sensitive help.

Refer to the Operation Manual for hardware specifications and for detailed descriptions
regarding booting, shutdown, cart relocation, UPS usage, safety, disinfection, sleeve
swapping and maintenance.
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Moving the Cart

Since the system is equipped with an internal UPS, the system may be left running during
short moves within the office. Before relocating the cart, unplug the power cable from the
wall and properly secure all cords and cables on the cart.

NOTE: The system will not allow scanning while operating on UPS backup power.

When fully charged, the internal UPS provides about 5 minutes of power. As soon as the
cart reaches its destination, it should be plugged in immediately. If the system is left
unplugged, warning messages begin to appear on the screen and the status of the internal
UPS battery will be displayed. When the internal UPS battery is nearly empty, the system
will automatically shut down in a safe manner.

For further details regarding the UPS and moving of the cart, refer to the Operation Manual.

iTero Scanner Sleeves

The system uses disposable white plastic Scanner Sleeves (imaging shields) to ensure
maximum infection control. A special red protective sleeve is used to protect the scanner
head during shipping and between patient sessions.

= At the start of each scanning session, remove the red protective sleeve and attach a new
white sleeve.

= At the end of each scanning session, discard the dirty sleeve according to standard
procedures. Then use disinfectant wipes to clean the scanner wand, scanner cradle,
keyboard and mouse. Finally, attach the red protective sleeve for protection.

WARNING: For a detailed description of changing scanner sleeves between patients, refer
to the Operation Manual.

Mouse & Foot Pedal Batteries

The system notifies the user when batteries need to be replaced in the mouse or foot pedals.
See the Operation Manual for battery specifications and for instructions on changing
batteries.

SD08414-B 5
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Entering the iTero Desktop

To enter the iTero desktop, the password is “cadent” (all lowercase).

Desktop Icons

The following icons should appear on your desktop.

The iTero Scanner application provides an intuitive user interface for
performing digital scanning. The doctor is guided through the scanning
sequence by means of visual, text and voice assistance. The foot pedals and
mouse are used to respond to screen instructions and perform scanning.

The Case Manager works interactively with iTero Scanner and handles file
communications between the doctor’s office, partnered labs, and the Cadent
Center. The Case Manager allows doctors to view the current status of all
cases.

In general, the Cadent Support icon should not be used. If you contact
Cadent Support for assistance, you may be requested to double-click this
icon to enable the support engineer to view & control your system from a
remote station.

Opening the iTero Scanner Application
Double-click the iTero icon to open the iTero Scanner application.
You will be requested to Login:

New Login System

iTero, iI0C & Case Manager are now authenticated by MyCadent.com
A My Cadent account ensures enhanced security and authorized access to patient scans

Scanners that are utilized by multiple doctors require a separate login for each doctor account

User Name: |J0hm Doe j
MyCadent account owners: N .
Enter your existing login email and password in the Sl |user@oadent.co.||
provided fields. Pacoword: |

¥ Remember Login

Sign In
Forgot Yiour Password?

Ifyou do not have a MyCadent account:
1. Click "Don’t Have MyCadent Account” Don't Have MyCadent Account

6 SD08414-B
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Chapter 2: User Interface

Getting Started Dialog

When the iTero Scanner application is opened, the system checks for “unsent” cases on
your local system. If such cases exist, the Getting Started dialog appears with a list of unsent
cases. (Cases which have already been sent, may be opened using the Case Manager.)

There are

T B

Stmith, John

Main Toolbar

2011 3:04 FPhd

The main toolbar of the iTero Scanner application contains the following icons.

Scan

Begin patient scan.

Send
Send case.

Save

Save case (see note below).

Help
Open the help menu.

View

Review scan results.

Menu
Open the menu.

Settings
Open the settings dialog

New / Rx

Open the Rx form.
If no case open, start an Rx form for a new case.

NOTE: The system saves the case automatically on a regular basis and saves the case
before closing it. In addition, you may use the Save command manually whenever desired.

SD08414-B




iTero Scanner User Guide English
View Control
The View Control can be used to manipulate the 3D image in the graphic window.
Zoom All Zoom Zoom Zoom Pan Rotate
(Default size) In Out Region View View
[
Rotate
Model Reset
Rotations

Visibility Control

The Visibility Control can be used to Show/Hide elements in the 3D model and to activate

measurement and analysis tools.

Scan Point to Point Grid Show/Hide Show/Hide
Browse Measurement Upper Jaw Lower Jaw
——
t S AW
ADA 19 Focus on Tooth
Tooth Show/Hide
Selection A

Margin Line
Hide/Show

Surrounding Surfaces

SD08414-B
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Center-of-Rotation

To move the center-of-rotation symbol to a different place on the 3D image, press Alt and
then click somewhere on the image. The 3D image will then rotate around that point.

You can choose to hide or display the center-of-rotation symbol using the General options.

General | System |Scanner |Preferences | Speech |Language

Startup

Restore window size

Tooth ID System
@® Quadrant (URS-LRE)

© ADA #1

@ FDI(1.584.8)

View center of rotation

Cancel Defaults

SD08414-B 9
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Multilingual Support

To change languages in the iTero Scanner application, use the Language Options.
NOTE: The change will take affect only after restarting the application.

General |System |Scanner | Preferences |Speech |Language

Language Selection

Please choose your preferred Language

Cancel
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Keyboard & Mouse Shortcuts

Functions ICursor Sequence Description
con
Zoom % Shift + left-mouse Zoom an area of the 3D image.
Alt + Shift + left-mouse . - :
Pan C%) OR Move 3D image within graphic

Mouse-wheel + right-mouse

window.

Alt + left-mouse

Rotate Freely /l‘;_j OR Rotate 3D image in any direction.
Mouse-wheel
Move cursor close to left or right
. T edge of graphic window, press
i -

Swivel Wff Mouse-wheel (at edges) mouse wheel, and move mouse
up/down.
Press Ctrl key and mouse-wheel

Swivel 12| Ctrl + Mouse-wheel and move mouse in circular

motion.

Rotate with Arrows

1]l ——

Click in graphic window and then
press arrow keys. Press up/down
arrows to rotate vertically. Press
left/right arrows to rotate
horizontally. Hold down arrow for
continuous rotation.

Move the
Center-of-Rotation

Alt + click left-mouse
OR
Click mouse-wheel

To move the center-of-rotation
symbol to a different spot on the 3D
image.

Hide/display the Scan Explorer

Scan Explorer Ctrl+E dialog.
N Click in any dialog or window and
Context-sensitive F1 then press the F1 key to display

help

context-sensitive help.

SD08414-B
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Chapter 3: Treatment Information (Rx form)

Opening a New Case

To register a new patient, click on the “New” icon in the main toolbar. Or click on “New Case”
in the Getting Started dialog.

Treatment Information (the digital Rx form)

The “Treatment Information” window is the digital prescription form used by partnered labs to
fabricate the requested restoration (eliminating the need for a paper form).

= Required fields are marked with an asterisk (*).
= Click a tooth in the tooth diagram to select preparation and bridge types.

= The “Number of Scans” field shows the total number of scans required for the case
(based on preparation and bridges selections).

= For more details, press F1 to open the help system.

e FTH Quadrant 3

B/ 22011 »
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Pre-Entering Patients

You may pre-enter patients in the system in order to save time during the actual patient
sessions. To pre-enter a patient, fill in the Rx and then click Scan Later. The patient name
will then appear in the Getting Started dialog each time you open the iTero Scanner
application.

On-Screen Keyboard (for Rx)

Information may be entered into the Rx form using the built-in keyboard on your
workstation. Alternatively, you may type using the virtual On-Screen Keyboard.

5= Onp-Screen Keyboard
File kKevboard Settings Help

escl F1| F2| F3| F4a 8 5| Fe| F7| Fa B Fa|F1of F11{ F12] pscf ] brk |

ing | hm} pup® /[

del | end| pd
4

SD08414-B 13
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Digital Signature

Each doctor may enter a digital signature in the system. Once entered, the digital signhature
will be displayed in the Signature field of the Rx form at the doctor’s office and at any
partnered lab.

= For multi-user systems where each doctor enters the system with a unique password,
each doctor is required to scan in his/her own signature.

= Signatures are stored in an encrypted format that cannot be used outside of the iTero
software (protecting users from unauthorized use).

= To create your digital signature, open the Preferences options and click “Print
Instructions”. The instructions sheet includes a calibration box and a signature box.

= ltis essential to use an ORIGINAL PRINTOUT of the “Signature Scanning Instructions”.
Do not use a copy or faxed version of the sheet.

e
e < . . 2
Signature Scanning Instructions |Tero

General |System |Scanner | Preferences |Speech |Language . .

x of each Case you
any tune, For multi-user
ctor s required to

Scanning Order

[NOTE : Always use an oniginal printout of this imstruction sheet (not a copy o fax)

1) Start Process
Open "Tools" menu, select "Options”, select “Preferences” tab, and pregs "Sean Signatwe” button.

2) Calibrate Scanner
9 ' ead i nuddle of Calibration Box. Be sure scanner
t touching amy borders. Level scanner head on

Lay thus

head is

Hole FillingMode —F ——————————————————————————— arface and

3) Sign in Signature Box

n

A Normal v R g s . . .
Sign wsing  dark pen (black or blue) and keep your signafive withuu the dotted pattern

4) Scan Signature

auner head to next section of
uned the entire signature. The
Signature
Print and sign instruction
r ned signanue, press the left pedal to indicate you are DONE and then
r sighature. The iTero application will exit

Calibration Box

Signature Box

Ok Cance Defaults

14 SD08414-B
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Chapter 4: Scan Tool

The Scan Tool consists of the following elements:

\. ,‘;1/ 5

Palatal, ADA 13

‘““Mu 0

‘

Guidance
For each individual scan, the system provides three types of instructions:

= Text command (Guidance, above the Viewfinder)
= Visual command (Guidance, in the top right corner of the 3D preview)
= Voice command (thru built-in speakers)

Viewfinder

The Viewfinder helps you to position the scanner head correctly.

= Use the crosshairs to align the scanner on the tooth indicated by the Guidance.
= The entire area displayed within the Viewfinder will be scanned.

= The Viewfinder is for positioning purposes only. In some instances, the target area may
appear slightly out of focus and you should attempt to improve the focus. Even if the
focus remains poor in the Viewfinder, the actual scan resolution will be fine.

Preview

After performing a scan in the Viewfinder, the results are displayed in the Preview for
immediate review. Press the Menu pedal and select Undo if you wish to retake the scan for
any reason.

SD08414-B 15
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Performing a Scan

In general, the scanning process is controlled using the two foot pedals. You can also use
the mouse to click commands in the Pedals dialog.

= To take a scan, first stabilize the image. Then press and release the right foot pedal to
Scan. The right pedal in the pedal dialog will become pressed to indicate that a scan has
been initiated. Once the image becomes steady, an audible beep indicates that the scan
is in progress.

= If the patient or doctor moves during the scan, the system may request a rescan.

= You may also decide on your own (for any reason) that you wish to redo the scan. Press
the left pedal (Menu) to open the menu. Pressing the left pedal again moved the menu
selection. After the menu selection is on Undo, press the right pedal (OK).

Pedals Dialog - ready to scan:

Pedals Dialog — menu open:

Prev
Undo

Rescan Segment

View

16 SD08414-B
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Scanning Tips & Techniques

Scanning Basics

= Each scan should have crosshairs following the natural shape of the arch (tangential).

= Buccal and lingual scans should include occlusal information (scan at 45 degree angle).

= We recommend the use of cheek retractors to avoid excessive tissue from being
scanned (especially for scanning anterior teeth).

Slow Scanner Response after Pressing Pedals

Ensure that an overhead light is not shining directly on the area being scanned.

Verify that patient and scanner are not moving during scan.

Check that saliva is not blocking the field of vision. Dry the area in question.

Ensure that interference is not occurring (tissue, lips, tongue, etc.)

Check that patient is holding tongue still.

L

If necessary, ask the patient to position tongue on the opposite side of the mouth.

Viewfinder Displays Blurred Image
= Try cleaning the external scanner sleeve window with clean cotton or paper.
= If cleaning does not help, try replacing the scanner sleeve with a new sleeve.

= If the new sleeve doesn’t help, contact Cadent support for assistance.

Jaw Relation Scans
= Center reference line should follow the occlusal plane.

= The jaw relation scan should contain teeth data from both jaws, for a better registration.

Scanning Samples

Occlusal View (prep) Buccal View (prep) Lingual View (prep)

Occlusal, ADA 5 Buccal 45°, ADA 29 Lingual, ADA 29

> i 1
\- i fi
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Buccal View (non-prep) Lingual View (non-prep) Jaw Relation

Buccal 45°, ADA 22 Lingual, ADA 31 Left Bite

ey K2

8D
e

Opposite Jaw First Finished

If user chose scanning order of “Opposite Jaw First”, at the end of scanning the opposite
jaw, the system announces that “Segment Finished”:

Segment Finished

The right pedal will show “View” and the left pedal will show “Add Scans”:

Add Scans View

Press “View” to pause the scanning and go to the View Tool to review the scanned jaw. In
the View Tool, press the “Scan” pedal to return to the Scanning Tool and scan the prep jaw.

Press “Add Scans” to add scans to the opposite jaw.

Scanning Finished

At the end of the scanning process, the system announces that “Scanning Finished”:

Scanning Finished

The right pedal will show “View” and the left pedal will show “Add Scans”:

Add Scans View

Press “View” to go to the View Tool to review the scanned jaw.
Press “Add Scans” to add scans to the last scanned jaw.

18 SD08414-B
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Chapter 5: View Tool (for Case Review)

Merge of Scan Images

After the scanning is complete, the system merges all scans into a single graphic image and
displays the resulting image for review. Progress bars are displayed during the merge
process.

Frocessing tooth ADA 20

Case Review with Patient Present

It is important to review the case with the patient still present, since rescanning may be
required. Be sure to check that proper retraction was obtained for a clear margin and that the
tooth reduction was adequate.

Checking Occlusal Clearance

Use the Show command in the Analyze tab to show/hide occlusal clearance colors along
with the Clearance Legend (showing mm distances). If you perform further reduction on the
preparation tooth, you will need to do rescanning afterwards.

SD08414-B 19
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Rescanning

To perform rescanning, click the “Rescan...” command in the Scan tab.
Choose the desired rescan area(s) and press “Rescan”.

The system will automatically begin the rescanning sequence. When complete, the system
indicates that the “Scanning is Done” and the updated scans are remerged for final review in
the View Tool.

dependant)

Cancel

Adding Scans

After reviewing the case in the View Tool, user may want to add scans to the model — to
capture missing areas or other additional data.

To add scans, click the “Add Scans...” command in the Scan tab
Choose the area in which scans should be added and press “Add Scans”.

The system will automatically go to scanning mode and continue from a segment according
to user selection. When complete, user should move back to the View Tool to review the
new merged model.

Start from:

Upper Left Arch

Cancel

20 SD08414-B
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Chapter 6: Sending Case

Once you have finished scanning and reviewing the case, click on the “Send” icon in the
main toolbar to send the case to the Cadent Center.

The iTero Scanner application will automatically close, and the file transfer process will be
handled by the Case Manager application. First the file data will be processed, and then the
case will be sent to the Cadent Center. To confirm that the file has been sent (or is queued
for sending), open the Case Manager.

SD08414-B 21
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Chapter 7: Case Manager

Overview of Case Manager

The Case Manager application works interactively with the main iTero Scanner application to
provide the following capabilities.

= Displays case essentials (case ID, patient, dentist, lab, etc.)

Shows current status of all cases.

Opens cases in the iTero Scanner application (for viewing & editing).
Uploads new cases from your office to the Cadent Center.

uu

Downloads the latest version of a case from the Cadent Center to your office for viewing
purposes. (OPTIONAL)

Entering Case Manager

Double-click the Case Manager icon to start the application.

The Case Manager application contains two tables, as described below.
Your selections in the top three fields (Case ID, Patient Name, Lab Name)
serve as a filter for determining which cases are displayed in the two
tables. Click Clear to empty the three fields and display all cases.

£ Case Manager

File Tools Help
EBATSR
Case ID Patient Name Lab Name: v | Clear
Cases to'Work On:
Case ID Patient Name Due Date State Time (Local) Dentist Name Lab Name Local State
G294 Jones Many 20090902 200908-19 18:02°28 Or DefsTRA, D74 Lab? Waiing for Send
Brooks, Patty 2009-09-10 2009-08-19 17:01:52 | Dr. Dds10A, Dds10A | Labl Mew File
Cases:
Case ID Patient Name Due Date State o
8280 SpecSleeveTwo Blackholetest 2009-09-02 Cadent Modeling
8281 pecSl Three Blackhol 2008-08-02 Cadent Modeling
8282 SpecSleeveF our Blackholetest 2008-08-02 Cadent Modeling
8283 SpecSleeveFive Blackholetest 2005-09-02 Cadent Modeling
8284 5 Sl Six. Blackholetest 2003-09-02 Cadent Modeling
8285 Spec5l 5 .Blackholetest 2009-09-02 Cadent Modeling
8286 SpecSl Eight.Blackhol 2003-03-02 Cadent Modeling
8287 SpecSl Nine Blackholetest 2003-09-02 Cadent Modeling
8288 SpecSl Ten,Blackhol t 2009-09-02 Cadent Modeling
8289 SpecSleeved Blackholetest 2003-03-02 Cadent Modeling
8290 SpecSleeveB Blackholetest 2003-09-02 Cadent Modeling
8291 SpecSleeveC. Blackholetest 2009-09-02 Cadent Modeling
8292 SpecSleeveD Blackholetest 2003-03-02 Cadent Modeling
8293 SpecSleeveE Blackholetest 2008-08-02 Cadent Modeling
8254 vones May 20080902
Brooks_ Patty 2005-03-10
© Sending\Receiving... There are 3 cases to work on.

22 SD08414-B




English iTero Scanner User Guide

Cases to Work On (top table)

The top table lists cases that have not yet been sent to the Cadent Center. These cases are
also displayed within the Getting Started dialog when opening the iTero Scanner application.
Double-click a case to open it. Or right-click on a case and select the desired action. The
case are color-coded as follows.

Blue Cases

New Case (not yet sent)
Case information has been entered but case has not yet been “sent” to the Cadent Center
(the case may or may not be scanned.) These cases require action by the user.

Red Cases

Waiting for Send
Case has been scanned and sent. The case file is queued for upload transmission in the
next communication session with the Cadent Center. No action is required by the user.

All Cases (bottom table)

The bottom table displays all cases from the past sixty days.
= This list includes all cases that appear in the top table (colored blue and red).

= This list also shows cases that have been sent (colored black bold). Viewing of these
cases is not required. If you do wish to view a case, simply double-click the case and it
will be opened for viewing. Once viewed, the case remains black (but not bold).

Refresh Case Manager Display (F5)
To refresh the table display, use the “Refresh” command in the Tools Menu (or press F5).

In general, the Case Manager tables are updated automatically and the Refresh command is
not needed. However, there is one particular situation where the Refresh command can be
of assistance. After sending out a number of cases, it may take a few minutes for the
communication session to complete. During this time, the Case Manager will not update the
display until all cases are processed. However, if you issue the Refresh command, the Case
Manager tables will be updated immediately based on the current state of communications.

For example, if six cases were sent but only two were actually transferred at this point in
time, pressing Refresh would update the tables accordingly.

Files Remain Red in Tables

If files remain red in the Case Manager tables for an extended period of time, there may be a
problem.

= Ensure that the Internet is operational in your office. If not, you may need to contact your
Internet service provider or local technician

= If the Internet is accessible in the office but not on the cart, contact Cadent Support.

= If the Internet is accessible on the cart but cases still remain red, try pressing
Send/Receive button in the Case Manager.
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